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1. I NTRODUCTION
Welcome to NorthEast Monitoring’s HE/LX Analysis Software. Used in conjunction with a NorthEast Monitoring Digital Holter Recorder - either the DR180 Series, the DR180 Series with the
optional OxyHolter cable, the DR200/HE or the DR300 - HE/LX Analysis - Basic allows you to
print full disclosure of your patient Holter recordings, to review all of the 3-channel recording onscreen, to confirm or correct all beat labels, to save particular ECG strips of interest, and to review
the report information before it’s printed. HE/LX Analysis automatically reads patient data from the
recorder’s flashcard - including entries made using the Event button - and saves sample strips of
event markers, diary entries, and high and low heart rates. Archiving is also included.
Optional oximetry from the DR180 Series with OxyHolter and 12-lead data from the DR180 Series
can also be analyzed, edited, and presented.

Intended Use and Indications for Use
Intended Use:
The HE/LX Analysis software is intended to provide a means for trained operators to analyze longterm ambulatory Electrocardiogram (ECG) recordings [Holter recordings]. The results of this analysis are intended to assist the physician in the interpretation of the recorded data. The HE/LX Analysis
software is intended to be used by a trained operator under the supervision of a licensed healthcare
professional.

Indications for Use:
1. The HE/LX Analysis software is to be used to analyze the data recorded by the NorthEast Monitoring, Inc. Holter recorders such as the DR180+, the DR181, the DR200/HE and the DR300.
2. Detection of Arrhythmias: The HE/LX Analysis software assists in the evaluation of ECG
recordings of cardiac rhythm when intermittent arrhythmias are suspected due to patient
symptoms such as palpitations, transient ischemic attacks (TIAs), syncope (fainting), or other such
symptoms as determined by the physician.
3. Efficacy of Treatment: The HE/LX Analysis software assists in documenting the effect of
pharmacological treatment of known arrhythmias is effective by measuring the frequency and
duration of the arrhythmia compared to the frequency and duration prior to treatment.
4. Pacemaker Evaluation: The HE/LX Analysis software assists in the evaluation of the function of
implanted pacemakers to insure that the pacemaker is functioning within prescribed limits.
5. Detection of Sleep Apnea: The HE/LX Analysis software assists physicians in determining the
need for clinical diagnosis and evaluation by polysomnography based on the patient's score.
The HE/LX Analysis software is to be used only on the order of a physician.

NorthEast Monitoring, Inc
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Recorder Definitions

Specifications for HE/LX
Analysis software

The following definitions are applied
throughout this manual:
• "DR180 Series" is a DR180+ or DR181
recorder
• "OxyHolter" is a DR180 Series recorder
with an optional OxyHolter or OxyHolter/
A cable
• "NEMon Holter" is any DR180 Series,
DR200/HE or DR300 Holter recorder

The software is designed to be used by a
trained operator under the supervision of a
licensed clinician for the purpose of evaluating the severity of arrhythmia as part of the
patient's medical evaluation for treatment.

Software Performance and
Specifications:

System requirements
The HE/LX Analysis software is to be used to
analyze the data recorded by a NEMon Holter
recorder. To run the HE/LX Analysis software, your personal computer must include:
• Microsoft Windows 7, 8 or 10 Operating
System
• a processor with a speed of 1 GHz or faster
• at least 1 GB of memory
• at least 10 GB of free space on hard drive
• a monitor with a resolution of at least
1280 by 1024
• a USB flashcard reader (included) or a laptop PC card slot
• a laser printer is recommended.

Operator knowledge
To use NorthEast Monitoring HE/LX Analysis Software, you must have extensive Holter
knowledge that allows you to properly identify sinus and paced rhythms, abnormal
rhythms, supraventricular and ventricular
arrhythmias, artifact, ST segment changes,
and pacemaker failures. In addition, all
instructions assume a working knowledge of
computers and, specifically a Windows operating system.

NorthEast Monitoring, Inc

User Specifications:

Arrhythmia Detection:
• Ventricular Premature Beats (VPBs)
• Supraventricular Premature Beats
(SVPBs)
Maximum time analyzed:
• 14 days
Presentation of data:
• Standard 25 mm/s for 3-lead and 12-lead
recordings
• 50 mm/s available for 12-lead recordings
• All 12-lead data displayed for 12-lead
recordings
• For oximetry recordings, SpO2 replaces
3rd channel
• Calibration indication can be provided in
reports
ST Segment slope:
• Positive or negative slope indicated based
on manual setting of cursors by trained
operator
LAN Capability:
Allows multiple users to access a common
database of patient data without conflict.

NEMM026-Rev_K
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Pacemaker detection:
• Displayed and annotated for the operator
Oximetry:
• When available, displayed by software
• When at least 4 hours of noise free data is
provided will calculate AHI (Apneahypopnea index) value.
Reports:
• Capability of labeling all arrhythmias
with the operators input
• Modular with ability for operator to
select modules to be included
• All reportable values and labels are editable by the operator
• Ability to remove and/or add sample
ECG strips

The HE/LX Analysis
Software Package
includes:
• HE/LX Analysis Software and
Manual disk
• License File disk
• HASP software key
• USB flashcard reader
• The HE/LX Analysis software must be
installed on your hard drive in order to
run. A license file must also be installed.
A demo patient has been provided with
your software. Otherwise, you will need
a flash.dat file from a Holter recorder to
begin analysis.

Algorithm Performance:
• Based on quality of recorded data*
• The following values were calculated
from the "MIT-BIH Arrhythmia Database":
•QRS Sensitivity: up to 98%
•QRS Positive Predictivity: up to 99%
•SVPB Sensitivity: up to 65%
•SVPB Positive Predictivity: up to
80%
•VPB Sensitivity: up to 95%
•VPB Positive Predictivity: up to 99%
*Noise in a recording can significantly
affect the performance of the algorithm,
however, all data is presented to the operator and can be presented in the report for
review by the physician. Results are no
lower than 2% of expected results. The
accuracy calculation uses the methodology
of 60601-2-47.

NorthEast Monitoring, Inc
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The Flashcard

Into a laptop PC card slot

ECG data recorded during the Holter
period is saved on a removable flashcard.
The DR181, DR200/HE and DR300
Holter recorders use an SD flashcard while
the DR180+ Holter Recorder uses a compact flashcard. To input the data from the
card to the computer system, first remove
the flashcard from the recorder, and then
insert it into your computer system’s card
reader.

First insert the flashcard into a flashcard
adaptor; to do so, hold onto the card by the
edge with the ridge and insert the opposite
edge into the adapter. Then insert the adaptor, right side up into the laptop’s card slot.
If a window appears listing what files are
on the flashcard, close it.

Depending on your computer and your
card reader, a window may appear
acknowledging that a card has been newly
inserted and listing what files are present
on the card. A recording saved by a NorthEast Monitoring recorder is named
“flash.dat.” If the window appears, close it.

Initializing a flashcard
To use a flashcard with a NorthEast Monitoring recorder, it must first be initialized
using the HE/LX Analysis software. To do
so, insert the card into the card reader,
close the Explorer window, if it opens, and
using the Holter software, select File >
Flashcard > Initialize. If a drive is found,
the Initialize Flashcard window opens.

Into a USB SD card reader
To insert an SD flashcard into the drive,
hold the card right-side up, with the missing corner away from you and to the right.
Insert the opposite edge into the opening of
the card reader. Push the card in gently
until it is fully plugged in. Some card readers have a light indicating when a flashcard
is properly inserted; if yours does, make
sure the light comes on.
Initialize Flashcard Window

Into a USB compact card reader
To insert the compact flashcard into the
reader, hold onto the card by the edge with
the ridge and insert the opposite edge into
the opening of the flashcard slot. Push the
card in gently until it is fully plugged in.
Some card readers have a light indicating
when a flashcard is properly inserted; if
yours does, make sure the light comes on.

NorthEast Monitoring, Inc

First determine that the correct drive has
been selected for your card. The drive that
will be updated should be highlighted in
blue, and if there is already a flash.dat file
on it, the check box will be populated.
If a drive has not been found, check to be
sure that a card is in the slot and the reader
is attached to the computer. You will need
to Exit and return to this screen to refresh
the Drive list.

NEMM026-Rev_K
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Lastly, check to make sure that the correct
card format option is selected - the correct
recorder should be selected and the appropriate format should be chosen. If you are
sure that your 3-channel DR181, DR200/
HE or DR300 recording will be less than
48 hours, you can select that option.

• Insert the flashcard into the computer’s
card reader.

Now press Erase and your card will be initialized for its next use.

• Let the software analyze the Holter
data.

Note: If you insert a card into the
recorder and get a message that the
“Flashcard is missing,” the card is not
formatted or erased properly.

• Start the NorthEast HE/LX Analysis
software.
• Enter/review information about the
patient and the recording.

• Review the Saved Strips, making sure
that all significant events are
documented and labeled properly.
• Type your comments about the Holter
test in the Report Summary.
• Create and print the final report to be
reviewed by a physician.

The Holter Procedure
NorthEast Monitoring HE/LX Analysis
software is used in conjunction with data
from a NEMon Holter Recorder. After a
patient has worn the recorder, you should
remove the card from the recorder and
insert the card in your computer system’s
card reader and the Holter signal will be
loaded onto your system. While the signal
is being transferred, the software processes
it, then you review the results, edit as
needed, and print the report.
An overview of the process is covered in
this chapter, and details are covered in subsequent chapters.
The Holter procedure typically includes
the following steps:
• Holter the patient using a NorthEast
Holter recorder.
• Remove the recorder from the patient
and remove the flashcard from the
recorder.

NorthEast Monitoring, Inc

Detailed information about the steps outlined above appears in subsequent chapters
in this manual.

Online help
In addition to the information in this manual and the on-screen help messages that
appear within the HE/LX Analysis software, more information and help is available at our web site www.nemon.com or
•
•
•
•

Toll Free in USA: 866-346-5837
Phone: [+1] 978-461-3992
Fax: [+1] 978-461-5991
email: support@nemon.com

Our “Technical Support” page on the website includes Frequently Asked Questions.
The most current version of this manual
and our software can always be found on
our web-site on the “Downloads & Documents” page.

NEMM026-Rev_K
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2. P ATIENT
I NFORMATION
The HE/LX Analysis software automatically retrieves the NEMon Holter signal and the patient identification number, the recorder number, the date and time the recording started, and any diary entries that the
patient saved using the Event/Record button on the recorder from the flashcard. All of this information is
carried forward onto the Patient Information screen when the flashcard is read. You are now responsible
for entering any additional data that you want to save on the Patient Information screen.

While running the HE/LX Analysis software, you have the choice of
opening the Patient Information window for (1) the last patient
whose Holter test was accessed (that is, the “current” patient), (2) a
previous patient whose Holter test has already been analyzed, or (3)
a new patient whose Holter test has not yet been analyzed. In the
first two cases, a patient record has already been created for the
patient and the Holter data for the patient has already been downloaded from the flashcard onto the hard disk of your computer.
The HE/LX Analysis has two tool bars that allow you to switch
between views for the patient that is currently opened. In this example, “Smith Mary” is the patient who is currently open and whose
data you are able to view.

Standard Basic tool bars

In the case of a new patient, a new Patient Information record must
be created and the Holter information downloaded from the flashcard. This chapter covers creating a new patient record first.
To enter information about a new patient’s Holter recording, the HE/
LX Analysis software must be running. When the program appears,
it displays a blank screen with the standard tool bars.

NorthEast Monitoring, Inc
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File drop-down options

Enter a new patient
To create a new patient, do the following:
1. Insert the patient’s flashcard into the
card reader and then click on File >
Open/New from the toolbar. The
Patient List will now appear.
2. From the Patient List, select an empty
directory (row) and double-click on it or
click the New button at the bottom of
the window.

• If you see a window that shows that
more than one flash.dat file has been
found, you will need to determine
which file to use before creating your
new patient. Once you determine
which is correct, click on and highlight
the file that you want to use at this
time.

3. A Patient Information window will
open, and click on the Copy Flashcard
or Start button to read the flashcard.
4. Now press the Start button for analysis
to begin.
Some things to be aware of:
• If you press the Copy Flashcard or the
Start button before inserting a card, you
will see a window that explains that
there is no flashcard in the drive. If this
happens, insert the flashcard into the
drive and click Retry.

NorthEast Monitoring, Inc

Multiple Flash found

If you are not sure which file to use,
you can use File > Preview Flashcard to
see recording information about the file
that was saved on each card. More
information on Preview Flashcard can
be found at the end of this chapter.

NEMM026-Rev_K
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New Patient Information window

Patient Information window

Type of Analysis / Report

As the Holter data from the card loads onto
your computer hard drive, you can enter or
edit the patient information. You can hover
your cursor over the title of a field to get
more information, when available.

Your system has been set up with a set of
configurations or Type of Analysis/
Reports to get you started.

Note: Once the flash.dat has loaded, the
“Copy flashcard” button in the Patient
Information window changes to “Copy
different flashcard.” If the ID from the
recorder does not match the patient,
remove the card, insert the correct one
and click “Copy different flashcard.”

DOB and Age
The D.O.B. and Age fields work together.
If you know the patient’s date of birth,
enter it, and the software automatically
calculates the patient’s age based on the
D.O.B. and the recording date. If you do
not know the date of birth, but know the
age, type a numeric entry in the Age field,
and select the appropriate unit (e.g., years)
in the Age Unit field. leave the age and
remove the D.O.B.
NorthEast Monitoring, Inc

Type of Analysis/Report
The Custom configuration is identical to
the Holter configuration, except that it
includes the Report header that you
entered in the Setup screen.
The configuration selected will load a set
of default settings for the patient. After
you save a patient with one type of analysis / report, you can change it, but all data
that you edited, except for patient information, will be lost.

NEMM026-Rev_K
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Notes
The Notes field allows an alphanumeric
entry that can be used to record information that might be helpful about the Holter
test or the patient. It is not printed in the
final report. To enter notes to be printed in
the final report, use the Comments section
of the Report summary.

BMI
HE/LX Analysis will calculate your
patient’s Body Mass Index (BMI) if you
enter the patient’s height and weight and
the appropriate units. A patient’s weight
status can be determined from the BMI as
follows:
• Below 18.5 - Underweight

automatically. You must type any significant information from the written record
manually into the Diary window from the
Patient Information Screen.
To open the Diary Symptoms window,
click the Diary button in the Patient Information window. If any entries are present
initially, those are the diary entries that
were automatically read from the flashcard. You can now add any additional
diary entries at this time.
Note: Whether the software uses a 12- or
24-hour clock is determined by your
computer’s setting in the Control Panel.

Date - The date and time will initially be

• 18.5 -24.9 - Normal

populated by the previous entry or the date
recorded. If you need to edit the date, you
can either do it manually by clicking on it
or double-click on it to open the calendar
edit screen

• 25 - 29.9 - Overweight
• 30 & Above - Obese

Time - You should edit the time by double-

BMI on Patient Information Screen

Diary Information

clicking on the box. Since no two diary
entries can contain the same date/time, be
sure that you edit the time so that is not the
same as what is entered above or below it.
If two entries appear at the same date/time,
you can edit the symptom to include both.

While wearing a NEMon Holter recorder,
the patient can identify symptoms and
activities in two ways:
(1) by pressing the Event/Diary button on
the recorder and, possibly, entering a precoded symptom or activity, or
(2) by keeping a written record of times
and symptoms or activities.
When analysis takes place, the software
reads the Event/Diary button information
directly from the flashcard and enters it
NorthEast Monitoring, Inc

Dairy symptoms window
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Symptom - To enter a symptom, first click
on the Symptom field next to the Date.
Then enter the text either by typing a freeform entry or by clicking on the arrow to
display a scrolling list of pre-typed entries.
To enter a selection from the list, click on
it; you can now edit the entry or move to
the next field by clicking on it. Once a
symptom is entered, the diary entry now
exists. If there is no symptom, the diary
entry does not exist.

Report or Configuration you have chosen
for your patient

When you have finished entering all written diary events, click the OK button to
save your entries and return to the Patient
Information window.
Delete - To delete a diary entry, click on the
trash can icon to the left of entry.
Editing - If you add or modify diaries after

analysis, the system will force an update
and some of your editing of the ECG may
be lost. For this reason, it is best to enter
diaries before the analysis is started.

6-Minute Walk
Assessment Window
If you have a 6-Minute Walk Assessment
patient, you are able to enter 6MWA data
using the window that is accessible at the
bottom of the Patient Information Screen.
The 6MWA window allows you to enter
data that wa recorded during the assessment. This data can be output by using the
6MWA front page that is available on the
Reports screen.

To Change Settings
During Holter analysis, the HE/LX Analysis software makes decisions about the
Holter signal based on a variety of predefined settings from the Type of Analysis/

NorthEast Monitoring, Inc

Settings window

You can change some of these settings by
clicking the Settings button in the Patient
Information window. You can now change
the following:
• Analysis duration determines how
many hours of data are analyzed. All
the ECG loads in from the compact
flashcard, but analysis stops after the
amount of time indicated here or at the
end of the Holter recording, whichever
comes first. It uses the HHH:MM
format, with the digits prior to the colon
showing hours and the numbers after
showing minutes. A maximum of 336
hours (14 days) may be entered.

What Strips to Auto Save
• Minimum HR indicates whether to
automatically save a sample strip of the
lowest heart rate (typically based on a
four-beat running average) observed
during the recording.
• Maximum HR indicates whether to
automatically save a sample strip of the

NEMM026-Rev_K
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fastest heart rate (typically based on a
four-beat running average and
excluding ectopy) observed during the
recording.
• Diary or event indicates whether to
automatically save a sample strip at the
time-of-day when either (1) the event
button on the recorder was pushed or
(2) an entry was manually typed into the
Diary Symptoms window.
• Save 1 strip/hour indicates whether to
automatically save a sample strip at the
beginning of each hour of the recording.

Processing criteria
• Primary channel determines which
channel is used first to locate R-waves
and do template matching.
• Alternate channel determines which
channel is used to do template matching
and also to locate R-waves if one is not
found in the primary channel.
• Pacemaker type contains four settings
that allow the software to expect certain
behavior:
5. Not paced means that the software will
not look for any pacemaker spikes,
beats or failures.
6. VVI means that each paced beat will be
preceded by a single spike.
7. AV sequential means that paced beats
will be preceded by two spikes, one
atrial and one ventricular.
8. DDD means that paced beats can be
preceded by either one or two spikes.

Note: Please note that when Oximetry is
being recorded, no pacemaker spikes will
appear on the Holter recording and no
pacemaker analysis will be done. This
setting should be set to Not Paced.
• Disable SVPB Counts - If a patient is
in intermittent atrial fibrillation or
flutter, you can choose to disable the
SVPB counts.
• Label Events as Artifact - allows you
to choose whether to label events as
artifact or not.
Within the Settings window, there are three
types of fields. For a numeric entry, click
on the field and type over the existing
entry. For a check box associated with a
setting, click to turn it on or off; a check
mark indicates that the setting is turned on.
For fields with an arrow to the right, click
on the arrow to list the other possible settings, then click on the new choice.
When you have finished making changes,
click OK to save those changes and close
the window, and click Cancel to close the
window without saving changes.
Note: Be sure to make any changes in
the Settings window before you work on
the final report. Manually saved sample
strips and typed comments will be lost
after some changes in the Settings
window.

Oximetry Settings
For any patients with oximetry data, the
Settings window also contains an Oximetry button, which opens the Oximetry win-

NorthEast Monitoring, Inc
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dow that allows settings to be reviewed
and adjusted.

Oximetry settings

The settings include:
• Desaturation threshold (percent)
defines the oxygen level (SpO2 value)
that every reading during a desaturation
event must be below. The duration of an
event is defined as a time period during
which no reading was above this level.
• Max. desaturation nadir defines the
SpO2 level that must be met for an
event to be identified as a desaturation
event. During the event, at least one
reading must drop to this level.
• Min. overall desaturation length (in
seconds) determines how long the
readings must remain at or below the
Desaturation threshold to be considered
a desaturation event.
• Max. length of artifact in a desaturation (in seconds) defines the
maximum amount of sequential artifact
that can occur during a desaturation
event and still have it reported as an
event.
• Min. separation of artifact segments
in desaturation (in seconds) defines
how close periods of artifact can be
within a desaturation event and still
have it reported as an event.

NorthEast Monitoring, Inc

Starting Holter Analysis
To start analysis after
entering patient data,
click the Start button
at the bottom of the
Patient Information window. The Analysis
window may appear or you may see Analysis in the lower left-side of the screen.
You cannot stop or cancel the initial analysis, and once analysis is complete, the
Patient Information will be changed.
To interrupt analysis, click the Stop button.
The analysis ends immediately, with data
only for the portion that was complete. The
unanalyzed ECG can be reviewed in Page
and printed in full disclosure.
After analysis is complete, proceed with
your review of the Holter recording. See
Chapter 3: Review Methods for details.

Edit patient information
for the “current” patient
After analysis is completed for a patient’s
Holter data, you can re-open the Patient
Information window and edit the information in it. To open the Patient Information
window for the current patient, select
Patient > Patient Information.
While most of the Patient Information window is the same as when new, there are
significant differences:
• The Re-analyze button replaces the
Start button because the Holter signal
has already been analyzed.
Note: If you choose to change the Type
of Analysis/Report at this time, you will
be forced to redo analysis and all edited
ECG data will be lost.

NEMM026-Rev_K
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Patient Information window for analyzed (not new) patient

• The absence of the Copy different
flashcard button.
• The addition of the Status button.

Status window
After a
patient’s
Holter signal
has been analyzed, the
Patient Information window also
includes a
Status button
Status window
that opens the
Status window. The Status window helps you keep
track of the status of each patient’s Holter
test. As you complete each step, you can
click on the check box next to each field in
the Status window to indicate that the step
has been completed.
The Status fields include:
• Edited indicates the Holter signal was
reviewed and edited as needed;
NorthEast Monitoring, Inc

• Printed means the report was printed;
• Verified means the report was
reviewed/approved by a physician;
• Locked removes all editing capabilities
from the Patient Information and
Review windows. No changes are
allowed.
The Archive field at the bottom of the status window fills in automatically when you
use the Archive to save a patient’s Holter
information. It will read either “Full” to
indicate that all Holter data is archived
with the patient report or “Report” to indicate that just the compiled report is
archived for this patient.For more information about archiving patient records, see
Chapter 8: Archive Patient Reports.
To save your data and close the Patient
Information window without starting analysis, click OK. To close it without saving
any changes, click Cancel.
To save your data and close the Patient
Information window without starting analysis, click OK. To close it without saving
any changes, click Cancel.

NEMM026-Rev_K
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The Current Patient

The Patient List

At any one time, only one patient is the
current patient - the patient whose information appears at the top of the screen,

You can keep multiple patient Holter
recordings and reports saved on your computer system. All of the patients currently
saved in the software appear in the Patient
List when you select File > Open/New
from the toolbar.

the patient you see when you select File >
Patient Information, the patient whose
ECG appears in the screen displays, the
patient whose report prints when you make
the request. To change the current patient
to a different one, either click on the appropriate name on the Patient List and click
Open, or double-click on the appropriate
line.
Also, you can change the current patient
using the << and >> buttons in the bottom
of the Holter LX window. << changes the
current patient to the previous one on the
Patient List and >> changes the current
patient to the next one on the Patient List.
Click each button repeatedly to move
backward or forward through the list. To
display a combo box listing all patients on
the system, click the arrow to the left of the
<< and >> buttons.

From the Patient List you can choose to
open a patient’s record by clicking and
highlighting it and pressing “OK” or by
double-clicking anywhere on the patient
line.
On the Patient List, if you don’t know the
meaning of a specific column, you can
hover your cursor over the heading for that
column and help will be displayed if it
exists.

Hover for Help on Patient List window

An example of the Patient List window
NorthEast Monitoring, Inc

NEMM026-Rev_K

Page 18 of 56

HE/LX Analysis Operator’s Manual - Basic

Patient Information: Preview data on flashcard

Customize the Patient List View

Delete button

You are able to customize the Patient List
for your specific needs in the following
ways:

This will allow you to delete one or more
patients. This data will be lost forever
unless saved or Archived in another directory.

• To change what
columns appear on
the list, right-click on
the top row of the
column headings. You
will now see a list
where you can check
or uncheck items to include or exclude
from the list.
•Once you have decided
what columns you want
to see, you can change
the position of the
column by clicking on it
and dragging it to a new
location.
• Grab the column divider
to increase or decrease
the size of any column.
•Sort on
any column by doubleclicking on the header
for that column. An
arrow will appear to
show you which
column is sorted.

New Button
When you select an empty patient directory, this button is enabled.

Open Button
Enables you to open a different patient
than is currently opened.

Preview data on
flashcard
If you would like to review the clerical
information on a flashcard before creating
a new patient record, you can insert the
card into the drive and then select File >
Preview Flashcard from the main toolbar.
This opens the Preview window, which
displays the identification and recorder
numbers, along with the date recorded and
the start time, directly off the card without
loading the information onto your computer’s hard drive. Use this feature to verify which flashcard contains a particular
patient’s Holter data.

Archive button
The Archive button at the bottom of the
screen will take you to the Archive screen
where you can select one or more patients
to save in the Archive directory. You can
also copy previously deleted records using
the Restore tab. More information is provided later in this manual.

NorthEast Monitoring, Inc

After verifying that the card is the correct
one, click OK to close the window, select
File > Open/New and follow the normal
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procedure described at the beginning of
this chapter.
If the information in the Preview window
does not match the information you have,
do not proceed without clearing up the discrepancy.

Permanently Delete Patient
Directories
If for some reason you would like to
reduce the number of patient directories,
you must first delete the patient records in
the directories you will delete. You can do
this by going to the Patient List, selecting
the patients, and then clicking the Delete
button. You will then need to go to the
Settings Utility window to reduce the number of patient directories, and then use
Windows Explorer to delete unwanted
directories permanently. Use the Archive
function to save patient directory prior to
deleting directories.

NorthEast Monitoring, Inc
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After loading the Holter signal from the flashcard to the hard drive of your computer, the HE/LX Analysis
software analyzes the signal and then displays it for your review. You can review an on-screen, colorcoded full disclosure of all the ECG, an interval table summarizing the heart rates and ectopy counts,
graphs showing the heart rate and RR interval data, selected strips saved for the final report, and a report
summary that describes the heart rates measured during the recorded period, along with any typed comments you enter.

Reviewing the Holter data
Note: NorthEast Monitoring recommends that the entire Holter recording for each
patient be carefully reviewed by a physician or other qualified person who knows how to
interpret Holter waveforms. This review can be done page-by-page using either the Page
window or the printed full disclosure.
Details of using the Page window are included in this chapter, while printing full disclosure
is covered in Chapter 4: Printing.

Color coding
Throughout the HE/LX Analysis software, the ECG is color-coded based on what the system has labeled each beat:
• Green: Beats the software has identified as normal.
• Yellow: Beats identified as supraventricular premature beats (SVPBs). They have a
normal morphology, but fall at least 20% early compared to the normal.
• Red: Beats identified as ventricular premature beats (VPBs). They differ significantly
from the normal; they are not necessarily premature.
• White: Beats identified as pauses, defined as RR intervals at least 2.5 seconds or longer.
White overrides any other color that the beat also qualifies for (e.g., red because it’s a
VPB).
• Light blue (cyan): Signal that appears to be contaminated by artifact.
• Cobalt blue: Beats identified as paced.

NorthEast Monitoring, Inc
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All data must be reviewed carefully to
ensure that you agree with the beat labels
the software has selected; if you do not
agree, you can change a beat label and its
color will change appropriately.
In addition to the labels the software can
provide for each beat, there are some
labels only you can use to relabel beats.
These are:
• Aberrant: Use this label to identify and
count beats as aberrantly conducted
SVPBs.
• Questionable (Unknown): Use this
label to separate out beats you cannot
identify and keep them from being
included in another category. They are
colored green, like normals.
• T-wave: Use this label if the software
has identified a portion of the signal as
a QRS, but it is not. This will merge its
RR interval with the preceding RR

interval. The signal will take the color
of whatever beat precedes it.

Reviewing data in the
Page window
The Page window allows you to review all
of the ECG stored during the Holter
recording, like an electronic full disclosure. The Page window is divided into two
displays: a miniature, single-channel presentation of the ECG and an expanded 3channel display with a background grid.
You can toggle the Page window format
back and forth between (1) only the miniaturized ECG and (2) a combination screen
(that shows the single-channel display on
the top half and the expanded strip on the
bottom half) using the Full Screen/Expand
button.

Page window - full screen
NorthEast Monitoring, Inc
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Note: On screen, the ECG is displayed in
color as explained previously. As you
page through the ECG, first determine
what the patient’s underlying rhythm is.
If the patient displays normal sinus
rhythm, then pay particular attention to
any signal, regardless of color, that
appears different from the patient’s
normal rhythm.

Single-channel page display
The single-channel page display contains a
blue highlight box surrounding one of the
QRS complexes. The time-of-day at that
beat is displayed in the time field in the
upper left corner of the window. The displayed ECG can be adjusted in these ways:
• To adjust the
ECG so that the
highlighted beat
appears in the
center of the
page, click
Center.

any display and the report, go to
Review > Invert/Hide to open the
Invert/Hide window. Click on the check
box for each channel to be inverted or
hidden; click on the check box again to
return the signal to normal. Click OK to
save any changes and exit. To close the
window without saving changes, click
Cancel.
In the single-channel display, you can visually review pages of ECG by using the
PageUp and PageDown keys, by clicking
on the down arrow of the scroll bar, or by
clicking the Scan button. Turn the Scan
button off by clicking it again. While scanning, use the + key to increase the speed of
the display, and use the - key to decrease it.

Invert/Hide window

A highlighted beat

• To move the
highlight box to a different beat, click
on the beat.
• To change the channel displayed, click
on the Lead field and select a different
channel from the list.

Relabeling a beat
If you determine that a particular beat is
not labeled appropriately, you can use the
relabel buttons to change the beat label. To
relabel, click on the beat to highlight it,
then click the appropriate relabel button.

• To change the amplitude of the
displayed signal, click on the Gain field
and select a different size from the list.
• To change the amount of time displayed
on each page, click on the Zoom field
and select a different amount of time.
• To invert the signal in a channel or to
completely eliminate a channel from

NorthEast Monitoring, Inc

Relabel buttons

The relabel buttons correspond to the beat
labels explained in the “Color coding” section on the first page of this chapter, with:
• A for artifact
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• V for ventricular (VPB)
• N for normal
• P for paced (only if pacemaker type is
on)

To save strips of an event longer than 7.5
seconds, drag the cursor across the ECG to
be saved (the selected ECG will turn purple) and then click Keep. In the Keep win-

• S for supraventricular (SVPB)
• B for aberrant SVPB
• Q for questionable/unknown
• T for T-wave
Keep window with continuous button

Note: If you relabel one or more beats,
when you exit from the Page window, the
software automatically updates all results
to reflect your changes.

Saving sample strips for the
report
As you page through the ECG, you can
choose to manually save sample strips for
the report. The 7.5-second sample strips
are printed as full-sized, 25 mm/second
ECG on a background grid. To save a strip,
click on the beat you want at the center of
the strip to move the highlight box there,
and then click Keep; the Keep window
opens. To label the strip, either type the

dow, you can enter the label of the first
strip in the series and then click the left
button, which indicates how long a time
period to be saved. Subsequent strips in the
series will be labeled “Continuous (x/n)”
(meaning strip number x out of a total of n
strips in the series).
To save multiple strips, all with the same
label, click on a beat at the center of the
ECG to be saved, then hold the Shift key
down and click on another beat. Then click
Keep. In the Keep window, click the but-

Keep window with multiple strips button

Keep window with OK button

label in the Description field or select a
label from the scrolling list; then click OK
to save the strip. If you decide to close the
Keep window without saving the strip,
click Cancel.
NorthEast Monitoring, Inc

ton labeled “n strips” to save all the
selected examples; click the button labeled
“1 strip” to save the last strip clicked. All
saved strips will have the label in the
Description field; change it when appropriate. Because the strips are likely to have
different heart rates, no heart rate fields are
presented.
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Expanded ECG display
The Expanded display shows three channels of ECG in the bottom of the Page window. To display the expanded ECG, click
Expand.
Note: Throughout the HE/LX Analysis
software, if oximetry data is present,
oximetry information appears where
channel 3 would normally be. In
expanded Page, the oximetry value is
displayed as a green trend line, while the
pulse waveform is displayed in white; if
hash marks appear, the data contained
too much artifact.
The expanded display includes a beat label
in the upper left corner and beat-by-beat
annotation of either heart rate or RR interval.
The expanded ECG in the bottom half of
the window and the single-channel display
in the top half of the window are linked.
The Expanded strip is centered on the
highlight box in the top half. If you move

the highlight box, the ECG displayed in
the bottom half changes appropriately.
To change the amount of time that appears
in the expanded mode, click in the Display
field in the toolbar at the center of the window and select the amount of time to be
displayed.
To print a strip of ECG centered on a displayed beat, along with a page of full disclosure of the surrounding rhythm, use the
Print button. When the Print window
opens, click the left button to print the current beat centered on the page of full disclosure, or click the middle button to print
with the beat on the first line. Click Cancel
to close the window without printing.

Measuring in Expanded Page
The two blue vertical calipers can be used
to make a variety of measurements. The
calipers can be dragged to specific locations on the ECG; clicking on the ECG
will also move the closer caliper to the
location of the cursor. To move both calipers while keeping them the same distance
apart, click on the Both check box in the
center toolbar, and then drag them where

Expanded portion of Page window with data fields
NorthEast Monitoring, Inc
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you want them; click Both again to move
each caliper separately.
To keep the calipers in the same locations
as you move through different screens of
ECG, click the check box next to Lock; the
calipers will stay in the indicated locations
unless you move them again. Click again
to turn off.
To measure the heart rate on the strip,
place the calipers two RR intervals apart;
the heart rate appears in the HR (2 RR)
field. To measure an RR or a PR interval,
place the left caliper at the start of the
interval and the right caliper at the end of
the interval; the time between them
appears in the Time field.
To make ST measurements, place the left
caliper in the isoelectric portion of the PR
interval, and place the right caliper where
you want the ST segment measurement to
be made; the vertical distance between
where the left caliper intersects the ECG
and where the right caliper intersects the
ECG will appear in the ST field for each
channel (labeled ST 1, 2, 3).

day appears on the horizontal axis, and RR
interval length (in seconds) is on the vertical axis. RR intervals are plotted so that
the range within each minute appears as a
vertical line; the top end of the line indicates the longest RR interval within that
minute, and the bottom of the line indicates the shortest RR interval within it.

HR Trend
The HR trend shows heart rate data
throughout the Holter period in one-minute
increments. Like in the RR trend, time-ofday appears on the horizontal axis. On the
vertical axis is heart rate in beats per minute. The information plotted is the average
heart rate for each minute.

The blue marker
The blue vertical marker is located at the
time-of-day of a particular 30-second segment. Click on either trend to move the
marker to a different time-of-day. The

If oximetry data is present, it appears in
SpO2 data fields to the right of the Display
field.

Reviewing the Trends
window
Open the Trends window by clicking
Trends in the Review toolbar or by selecting Review > Trends in the primary Holter
toolbar. The display includes two trend
graphs of information from the recording.

RR Trend
The RR trend shows the range of RR interval measurements throughout the Holter
period in one-minute increments. Time-of-

NorthEast Monitoring, Inc

Trends window
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time-of-day that appears in the large data
box indicates the time-of-day at the
marker. The data boxes at the top of the
display indicate the heart rate (HR), the
shortest RR interval (RR Min), and the
longest RR interval (Max) in the minute
where the marker is located.

Amount of time displayed
You can expand the trends by decreasing
the amount of time displayed across a single page. To change the amount of time
displayed, click on the arrow in the Hours
field and select the number of hours you
want displayed per page.
When Hours is set to less than 24 for a 24hour recording, there are multiple pages of
data. To move from one page of data to the
next, use either the PageUp and PageDown
keys on your keyboard, or the scroll bar at
the right edge of the window.

Shorten analysis time
If the Holter period ends prematurely, you
can either throw out the information as
artifact, as described in the section above
or you can shorten the analysis time.
To shorten the analysis time, in the Trends
window, click to move the marker to the
time-of-day at which you would like to end
analysis, then select Review > Shorten
analysis time. When the window opens to
confirm the command, click Yes to re-analyze the data, stopping at the time indicated. To close without re-analyzing, click
No.

Relabeling artifact
If, after looking at the Holter signal on the
screen or on the full disclosure printout,
you see that the signal contains long periods of artifact that might be included in the

NorthEast Monitoring, Inc

heart rate measurements, then you can
relabel those periods as artifact in the
Trends window. Once relabeled as artifact,
any signals that the software identified as
QRS complexes within that time period
will no longer be included in the heart rate
calculations or the arrhythmia counts.
To relabel a section as artifact, open the
Trends window and, using the mouse to
drag from the time-of-day at the start of the
artifact to the time-of-day where it ends,
select the period you want to relabel artifact. It will turn pink. Then press the Artifact button. When the confirmation
window appears, click Yes to relabel it
artifact.

Confirm window

To close the confirmation window and
cancel the relabel, click No.
Note: When oximetry data is present the
artifact button can only be used to
artifact SpO2 data. If you need to artifact
HR data, you will need to do this on the
Page screen.

The Oximetry Trend
For oximetry patients only, the trend
screen contains oximetry data, including
(1) a color-coded trend line (colored the
same as the beat labels) of SpO2 data on a
scale from 60 to 100 percent saturation and
(2) a white trend showing pulse oximetry
data.
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On the trend screen, the Desat(uration) On
and Off buttons appear. This allows you to
manually identify desaturation events that
were not identified automatically. To create a new desaturation event, drag across
the Trend window from the beginning of
the event to the end. The trend is highlighted in magenta. Press Desat On to
identify that period as a desaturation event;
the event is automatically entered in the
Desaturation table in the Tables window.
You can undo the change in the Trends

Desaturation On, Off buttons

window by dragging to select it again and
then pressing Desat Off.

Reviewing Saved Strips
In addition to printing out full disclosure,
the report can include full-size, 7.5-second, 25 mm/sec strips on a background
grid. Four types can be saved automatically: Minimum HR, Maximum HR,
Event/Diary entries, and a sample strip for
each hour of the recording. You can also
manually save strips while reviewing the
Holter in the Page window (see “Saving
sample strips for the report” earlier in this
chapter).
To review the saved strips before printing
the report, click Saved Strips in the Holter
menu.
The Saved Strips window displays a miniature version of the strips 12 at a time.
Each is labeled with its strip label and the
time-of-day at which it occurred. If you
have saved lots of strips manually in the
Page window, you can page through them
using either the PageUp and PageDown
keys or clicking on the up and down
arrows of the scroll bar.

NorthEast Monitoring, Inc

The strips are initially sorted by strip label.
If you would rather review them ordered
by time-of-day, select Time from the
choices in the Sort field.

Changing the active strip
At any time, there is only one active strip,
the strip outlined in blue. Three fields
above the strips refer specifically to the
active strip and cannot be changed. Those
fields include time-of-day, a strip number,
and heart rate.
To change the active strip, click on the one
you want so that the outline surrounds that
one. You can also change the active strip
by clicking the List button in the toolbar to
open the List window. The List window
lists each strip label and corresponding
heart rate in order of time-of-day. To display a particular strip from the list, click on
the appropriate entry on the list and press
OK, or double-click on the entry. To exit
without changing the active strip, press
Cancel.

Editing a strip label
To change the label of the active strip,
click on Edit in the toolbar. The Edit window opens; it includes a field with the current label of the strip and the heart rate of
the ECG in the strip.

Edit window in Saved Strips

You can either type over the existing strip
label in the Description field or select an
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alternate label by clicking on the arrow at
the right end of the Description field and
selecting a label from the displayed list.
To change the heart rate on the strip, click
on the HR field and type over the existing
entry.
When you have completed your changes,
click OK to save those changes and exit;
click Cancel to exit without saving any
changes.

Deleting strips
If you decide to delete one or more of the
strips from the final report, you can do that
in the Saved Strips window. To delete one
strip in the Multiple strip display, click on
it to make that strip the active one, then
click Delete in the toolbar. To delete more
than one strip, click on the first strip to
make it the active strip; in addition to the
blue highlight around the strip, there is
also a yellow highlight around the time-ofday, indicating that the strip is selected.
Click on any additional strips you want to
delete, then click Delete in the toolbar. All
of the selected strips (as indicated by the
yellow highlights) are now deleted.
When you delete a strip, its label becomes
red; strips with red labels are not included
in the printed report. To retrieve a deleted
strip, click on it and then click Delete in
the toolbar again; the label text changes
back to yellow.
To delete all of the strips displayed, click
the button labeled Del/Undel All. All of
the strip labels turn red. To retrieve all of
the strips displayed, click the button again.

Deleting channels from a strip
To delete one or more channels of a strip,
but not the entire strip, click on the strip to
make it active. Then, click on one of the

NorthEast Monitoring, Inc

check boxes labeled Channel 1, 2 and 3.
For a particular strip, if a check is present,
the channel will be included; if a box is not
checked, the channel will be deleted.
To delete the same channel from all strips,
delete the channel from the active strip,
then click All. When the Confirm window
appears, click Yes to delete the channel(s)
from all strips. Click No to cancel the All
command.

Replacing a strip with an
alternative
The maximum and minimum heart rate
strips that are saved automatically by the
software can be replaced by an alternative.
The software selects sample strips for
those types automatically. If you would
prefer to select a different one (perhaps
because the selected one contains artifact),
click on the strip to make it active; the
Alternatives button appears.
When you click Alternatives, the Alternatives window opens, displaying other
choices for that label. The strips are sorted
by heart rate, with the current selection the
first one, in the upper left corner.
To select a different strip, click on the strip
and then the Select new Alternative button.
The window closes and the new strip
appears in the Saved Strips window. To
exit from the Alternatives window without
changing the strip, click the Back to Saved
Strips button.

Measuring
The data fields in the center of the toolbar HR (2 RR), Time, and the ST indicators
for each channel - contain data calculated
based on the two blue calipers in the active
strip, just as they do in the Page window.
As you drag the blue calipers, those fields
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change, reflecting the new caliper positions.
To measure a two-beat heart rate, place the
calipers two RR intervals apart; the measurement appears in the HR (2 RR) field.
To measure ST in any of the channels,
position the left caliper in the isoelectric
area of the PR interval and the right caliper
where you want to make the ST measurement; the measurements for each channel
appear in the appropriate fields.
To move the calipers keeping them the
same distance apart, click the check box
next to Both and then drag the calipers.
Click Both again to remove the mark and
move them separately.
To keep the calipers in the same locations
as you move through different screens of
ECG, click the check box next to Lock; the
calipers will stay in the indicated locations
until you move them again. Click again to
turn off.

strip. It then fills the Saved Strips window.
Each beat is labeled with either the heart
rate (BPM) or the length (in milliseconds)
of the RR interval following the beat.
The blue measurement calipers and the
related data fields work in this window as
described in the previous section, “Measuring.”
All other buttons and fields work in the
Expanded display just as they do in the
Multiple strip display. Use PageUp and
PageDown to display the other strips.To
return to the Multiple strip display, click
Multiple in the toolbar.
Note: Saved Strips are re-compiled after
every update or re-analysis, so be sure to
make changes to the automatically saved
strips only after you have completed all
other editing. Any editing of strips that
occurs before an update or re-analysis
will be lost.

Printing the ECG now
To print a strip of ECG centered on a displayed beat, along with a page of full disclosure of the surrounding rhythm, use the
Print button. When the Print window
opens, click the left button to print the current beat centered on the page of full disclosure, or click the middle button to print
with the beat on the first line. Click Cancel
to close the window without printing.

Print choices

Expanding the active strip
To view a strip more closely, either click
Single in the toolbar or double-click on the

NorthEast Monitoring, Inc

Reviewing Tables
The Tables window consists of a General
table and optional Oximetry tables (the
Oximetry tables appear only for recordings
with oximetry data):
• General - This is an interval table that
lists the time-of-day at the start of the
interval; the low, mean and high heart
rates calculated during the interval (see
Appendix A for details of heart rate
calculations); the total number of beats
identified and counted in the interval
(this excludes periods of artifact); the
amount of time analyzed (this also
excludes artifact); the total number of
SVPBs; and the total number of VPBs.
• SpO2/HR summary (optional) - The
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General table in Tables window

table lists minimum, maximum and
mean SpO2 and heart rate values for the
monitored period.
• SpO2 summary (optional) - The table
indicates how much time (and
percentage of the monitored period)
was spent within certain SpO2 ranges.
• Heart rate summary (optional) - The
table indicates how much time (and
percentage of the monitored period)
was spent with certain heart rate ranges.
• Desaturation table (optional) - The
table indicates the start time, end time
and duration of each detected desaturation event. The parameters defining
desaturation events are determined by
the oximetry settings accessible in

Patient > Patient Information > Settings
> Oximetry.

Editing table entries
To edit information in the General table,
you can use either the Edit or the Zero button; the Oximetry tables cannot be edited.
In the General table, the Edit button opens
the Interval Table Edit window that allows
you to change information within the data
fields for a particular interval. To use the
Edit button, click on an interval to highlight it, then click Edit.
Within the Interval Table Edit window, you
can click in any data field to type in your
changes. Highlight an existing entry and
type over it, or click to the right of the

Interval Table Edit window

NorthEast Monitoring, Inc
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entry and backspace to eliminate it and
then type your entry.
Editable fields appear with data against a
white background. Those you cannot edit
have a blue background; these include
time-of-day at the start of the interval, time
analyzed, total number of beats, total
paced beats, total VPB count, total VTAC
runs, total VTAC beats, total SVPB count,
total SVT runs, total SVT beats, and the
VTAC and SVT heart rates. The total beat
counts are not editable because they are
calculated from other field data present in
the table; as you make changes to the other
fields, the total counts change appropriately.
To save your changes and exit, click OK.
To exit without saving changes, click Cancel.
Note: The VPB and SVPB total beat
counts are the only ectopy data that
appear in the General table in the Tables
window. To change those totals, you must
enter new data in the singles, pairs or
runs fields.

To completely eliminate all information
within an interval, use the Zero button,
which opens the Interval Table Zero window. In that window, each data field has an
associated check box that determines
whether to include or exclude the data for
that field in the table. To zero data for a
particular field, click on the check box so
that a check mark appears. Click again to
remove the check mark.
Click on as many data fields as you want
zeroed out, then click OK to exit. Click
Cancel to exit without saving any changes.
Select/deselect all buttons are available for
each section. Use them to turn on or off all
data fields within a section - general information, ventricular or supraventricular.
Note: Be sure to make any changes to
the tables carefully. Incorrect information entered in this window can cause
inconsistencies in the printed report.

Printing the General table
To print the table, click Print to open the
Print window, which should list your
printer type and default to
one copy. Click OK to print.
Click Cancel to close the
window without printing.

Closing the Tables
window
Click OK to close the Tables
window.

Interval Table Zero window
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NEMM026-Rev_K

Page 32 of 56

4. P RINTING
The HE/LX Analysis software generates printed reports composed of report modules that can be included
or excluded, along with full disclosure of all or part of the Holter data. Modules can be selected individually, and include the first page with clerical information, the second page containing typed comments, and
a list of diary entries for the patient, along with sample strips in standard 25 mm/second format. Full disclosure of any interval can also be included. If oximetry data was recorded for the patient, oximetry modules can also be included in the printed report.

Final Report
Choosing report modules
To access the report modules that can be included in the final printed report, select
Reports from the Review toolbar to open the Reports window. The modules that are
available for the current patient are listed in the right half of the Reports window; if the
optional Oximetry modules appear, oximetry data was saved during the recording. The
modules include:
• Patient Information. This is the standard front page, with a report heading, the
information entered in the Patient Information window, and the Report Summary.
• Comments Page. This also contains some clerical information about the patient,
along with a large area for comments that were typed in the Comment window of the
Report Summary.
• List of Diary Events. This lists the time-of-day and symptom for each entry in the
Diary Symptoms window accessible from the
Patient Information window.
• Full-Sized Strips. This presents the sample
strips in a 25 mm/second format, with three
strips per page.
• Full Disclosure Strips. Full Disclosure
Strips. This report will create a page for each
manually saved strip. Each page will include a
full-sized strip at the top with 6 minutes of
full disclosure below.
• Oxy and HR Trends - 24 hours (optional).
This prints a compressed trend of oximetry
NorthEast Monitoring, Inc
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and heart rate data, with 24 hours across
one page.

turn and type. You can leave any line
blank.

• Oxy and HR Trends - 2 hours
(optional). This prints an expanded
trend of oximetry and heart rate data,
with 2 hours across each page.
• Oxy and HR Summaries (optional).
This table presents the minimum,
maximum and mean SpO2 and heart
rate values for the monitored period.
• Oxy Values with Full Disclosure
(optional). This prints two-channel full
disclosure of the ECG annotated with
SpO2 values.
• Oxy Trend with Full Disclosure
(optional). This prints full disclosure of
the ECG, along with a trend of the SpO2
data at that time.
• Oxy Respiration - Full Disclosure
(Apnea Patients Only)
To include a module in the report, the
check box next to the module name in the
Reports window must contain a check
mark. Click an empty box to add a check
mark, and click a check mark to remove it.
To turn all of the modules on or off, click
the All On/Off check box under the report
module list; to change them all again, click
the All On/Off check box again.

Including a heading on the front
page of the report
The Patient Information module of the
report includes a report heading so that you
can customize the report for your facility.
The heading consists of five lines of freeform text, with up to 34 characters per line.
To enter text in a line, click on the field
and type your entry. Click on each field in

Report heading in Reports window

If your address comes up automatically,
but you would like to change it for a particular patient, click on the field, use the
Delete/Backspace keys to clear what is
there, and then type your entry.
To select an address from a different configuration (i.e., one you entered previously,
but did not select when you started this
new patient), click the List button. That
opens the Report Headings window listing
your options. Click your choice to highlight it, then click Copy to close the window and replace the address.

Selecting which strips print in
the report
Although both manually saved (those
saved using the Keep button in the Review
windows) and automatically saved strips
appear in the Saved Strips window, they do
not all need to be included in the final
report. To include just the automatically
saved strips, open the Reports window and
select Automatic in the Saved strips field.
To include just the manually saved strips,
select Manual for that field. To include
both types, select Both.

Choices for Saved strips
NorthEast Monitoring, Inc
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If the final report is printed including
either the half-sized or the full-sized strip
module, it will include only those strips
designated in the Saved strips field of the
Reports window.

Full disclosure
Full disclosure is a printout of all the ECG
recorded during the Holter monitoring
period, in a miniaturized format. Each
page is annotated with time-of-day along
the left margin.
You can print full disclosure in a variety of
formats based on the channels printed and
the amount of time printed on each page.
Full disclosure can be printed for a single
channel (channel 1 or 2 or 3) or for two
channels together on a page (channels 1
and 2, or channels 1 and 3, or channels 2
and 3). It can be printed with 30 minutes of
ECG per page or 60 minutes.

Determining what to print in full
disclosure
To request a full disclosure printout, select
Reports from the Review toolbar. In the
Reports window, there is a section with
settings that control full disclosure. It
includes three fields:
• Time per page check boxes. At the top
of the section are two check boxes
labeled 30 min/page and 60 min/page.
To print full disclosure, there must be a
check mark in one of these check boxes.
Click on the check box to make a check
mark appear in it; click on the other
check box to put the check mark there
and remove it from the first check box.
To eliminate a check mark, click again
on the check box.

select an entry from the Channel field.
Click on the arrow to display your
choices, and then click on your
selection.
• Intervals to include. Full disclosure
can be printed for each hourly interval,
all of the hourly intervals, or whatever
combination you select. For each Holter
test, the Intervals field lists all hourly
intervals in the recording. To include an
interval in the full disclosure printout,
click on the check box next to the timeof-day at the beginning of the interval.
Click on as many intervals as you
would like to print. To eliminate an
interval from the printout, click on the
check box to get rid of the check mark.
To check all intervals on or off, click on
the All On/Off check box below the
interval list.
Note: The time per page check boxes
control how much total ECG is printed
per page. If you choose to print two
channels of ECG, the 30 min/page setting
will print both channels during a 15minute time
period, and
the 60 min/
page setting
will print
both
channels of
a 30minute time
period.

• Channel(s) field. To indicate what
channel(s) to print in full disclosure,
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Reviewing the Report
Summary
A report summary is printed on the front
page of the printed report. An optional
comment page can be printed as the second
page. To review and edit the information
that appears on those pages, select Reports
> View Summary.
Four different front pages can appear,
based upon the type of patient that you are
reviewing:
• Standard
• Oximetry
• 6-Minute Walk Assessment
• Sleep Apnea report (for Oxy patients
with AHI#).
Information in the Standard Report Summary includes:
• the length of time the patient wore the
Holter recorder
• start time
• mean heart rate, calculated by dividing
the total number of beats by the time
analyzed
• maximum heart rate measured, based on
a four-beat running average
• time-of-day at which the maximum
heart rate was observed
• minimum heart rate measured, based on
a four-beat running average
• time-of-day at which the minimum
heart rate was observed
If oximetry data was recorded for the
patient, the oximetry Report Summary
appears.

Editing the Report summary
The View Summary window displays the
front page as it will appear on the bottom
of the first page of the report. Every character can be edited, if you choose to do so.
You can select the text and then delete it or
type over it, or you can simply add to the
information that is already there.
To add comments to the end of the summary, click after Comments: and then
either type the comment or select a line
from the Phrases window in the left portion of the window; after selecting the
phrase, click Add to copy it over into the
Comments area.
The Phrases list appears only if you
entered at least one sentence in Patient >
Preferences > Summary phrases.
Note: Because the printed report
includes the information from the Report
summary exactly as it appears here in the
Report Summary window, be sure to
make changes carefully.
To access the additional Comment window, click the Comments tab, then type the
information you would like to appear on
the Comments page of the report (typically
page 2). Click on the Summary tab to
return to the previous Report Summary
window, the one that appears on the front
page.
If you start making changes to the text in
the Report Summary window, but then
decide you would like to revert to the original information, click the Reset button;
your changes to the Summary window will
be deleted and the text will return to the
original.
When the information in the window
appears as you would like it, click OK to
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save your changes and exit. Click Cancel
to exit without saving your changes.
Note: The Report Summary is newly
compiled after any update or re-analysis,
so do not make changes here until all
other editing is complete. If you make
changes and then update or re-analyze,
you will have to re-enter your changes.

Status indicators
Note that the Status indicators from the
Patient Information window also appear
here in the Reports window. Use them to
keep track of whether a patient’s Holter
has been edited, printed, and/or verified
already. Click the check box to add or
remove a check mark.

Reviewing the report
To review the report on screen before
printing it, click the Review PDF button at
the bottom of the Reports window. This
launches the Adobe Acrobat program that
generates a pdf file for you to review onscreen.
When you click the Review PDF button,
the report compiles and then is displayed
on the screen, starting with page 1. The onscreen report appears as a continuous document that can be
scrolled through. You
see it on the screen in
Acrobat Reader. Refer
to Acrobat Reader documentation for user
instructions.
The report cannot be
edited or changed in

any way in this display mode, but you can
go back to the Review methods (Saved
Strips, Page, and Trends windows), or to
the Report Summary or the Patient Information window to make changes before
printing the final report.
If you would like to send this report to a
different site, you can Save a Copy using
the Adobe Acrobat software. You can then
send the pdf file created, and the other site
can use Acrobat Reader software to view
and/or print the report.

Printing
When the fields within the Report window
are set properly for a patient, click the
Review PDF button for a final review.
Note: Sometimes when you click the
Review PDF button on the bottom of the
Reports window, a confirmation window
appears asking, “OK to use the previously
created report?” That means that a report
has already been compiled for this
patient’s Holter test. If you are sure that
no changes have been made to any Holter
setting or any information in the report,
click Yes to print a report identical to the
previously compiled one. If you are
unsure whether any changes have been
made, click No; a new report will compile
and then print.
Once a new report is created, Adobe
Reader will open and your report which is
now an Acrobat file will be visible.
Note: In order to print, you must ensure
that the Adobe Reader settings are appropriate for the Holter report. In File >
Print, (1) Print as Image must be turned

Summary phrases
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NEMM026-Rev_K

Page 37 of 56

HE/LX Analysis Operator’s Manual - Basic

Printing: Adding Logo to report

on and (2) Expand small pages to paper
size (version 5) or Fit on page (version 6)
must be turned off. Printing the report
without the proper settings will result in a
non-diagnostic-quality printout.
At any point after printing the report, you
can still edit the information and retrieve
additional strips, and then print the report
again.

Closing the Reports window
At any time, you can save changes to the
Reports window settings, but exit without
printing the report, by clicking OK. Or, to
exit without saving any changes to the settings, click Cancel.

In order to get your logo to appear on the
report, you will need to review the report
PDF file.
Possible options for logo file with the following syntax:
Optional values are:
"scale" -- scale the image by this amount.
A scale of "1" means 72 DPI. A scale of
"0.5" would therefore be 144 dpi, etc.
"dpi" -- only used if "scale" is not specified. This specifies the actual DPI for the
image.
"x" -- the x location of the image. This is a
floating point number. X increases from
left to right across the page.
"y" -- the y location of the image. Also a
floating point number.

Adding Logo to report
You will need to place two files in the bin
directory in order to put a logo on your
report.
1) The first file is your logo itself. The
logo file will need to be a GIF or JPEG
file. We recommend 180 - 240 dpi with a
scale from 0.4 to 0.3 for good printer display. The final size should be about 1 by 1
inches, so that it fits on the top of page.
Save this file in the bin directory and call it
logo.jpg.
2) The second file is a pointer to your logo
file. Create this file using Notepad and
save it as "logo.mod" in the bin directory.
The logo.mod file will have one line preceded by a space. Here is an example of
the line that you may want to try first, “
<logo.jpg?scale=0.3,y=1040>”.
At a minimum, you will need to specify a y
value, with y increasing from bottom to
top up the page. A value of 1040 places the
bottom of the logo in a good spot, and then
you can tweak the number as required.
NorthEast Monitoring, Inc
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You can customize certain parts of the HE/LX Analysis software to better suit the needs of your facility.
The customization options range from entering the names of physicians who order Holter tests - so that
you don’t have to type them in each time - to which Review window you want to come up automatically
at the end of analysis.

Preferences window
To open the Preferences window, select Patient > Preferences. The following options are available:

Draw grid
You can choose whether or not there is a background grid behind the Expanded strip displayed in the
Page window. Click on the Draw grid check box to change the setting. A check mark indicates that a light
grid will appear. No check mark means that the grid
will not appear.

Use large fonts
This determines the size of the font
used throughout the software. A
check mark indicates that a large font
is used for all menu items, selections
and text.

Use large fonts in toolbar
This determines the size of the font
used in the Holter Review toolbar. A
check mark indicates that a large font
is used for the Review items.

Preferences window

Faxable report
When checked, gray backgrounds will be suppressed so that the report can
be faxed.

NorthEast Monitoring, Inc
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After analysis show
This field allows you to determine which
window is displayed upon the completion
of analysis. Your choices include any of
the Review windows and the Reports window. To change the setting, click on the
arrow in the field to display the list of
choices, then click on your selection.

many names as you need, click OK to
close the Edit physician names window.
To exit without saving changes, click Cancel. To delete an entry, click on the line so
that the field is outlined and then click
Delete.
You can similarly enter and edit the Interpreting Physician names.

Enter Summary phrases

Choices for display after analysis

Enter Physician names
You are able to customize the entries for
the Physician or Interpreting Physician
field in the Patient Information window
that appear in the patient information area
of the printed report. Entries in that field
can be preset so that you can make a selection from a list instead of typing the physician name in for each Holter test.

You are able to customize entries for the
Comments area of the Report Summary
section of the printed report using this button.
To add a sentence, select Patient > Preferences > Summary phrases. Click on a field
and type a sentence as you want it to
appear in the Report Summary. When all
sentences are complete, click Done. To
delete a line, highlight it and then click
Delete.

Physician list in Patient Information

To add a name to the list in the Physician
field of the Patient window, go to Patient >
Preferences > Physicians. In the Edit physician name window, click on the first line
and type the name as you want it to appear
in the report. To enter another name, click
on the line below the first and type that
name. Use the scroll bar to access additional lines. When you have entered as

NorthEast Monitoring, Inc

Edit summary phrases window

The sentences will be available for you to
select when you display Reports > View
Summary, so that you don’t need to re-type
common phrases.
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P ATIENTS
Before the Patient List directory is full, you will want to archive and delete patient records to make room
for new ones. You can choose to do this manually or it can be automated to run on a regular basis.

The HE/LX Patient Archive Tool
HE/LX Patient Archive is
accessible by going to the
File > Open/New > Patient
List and clicking the Archive
button at the bottom of the
screen. The Archive tool has
two tabs - Archive Patients
and Restore Patients.

Archive Patient Tab selected

Archiving a patient consists of two steps: 1) copy the patient to the Archive folder and 2)
delete the patient from the Patient List. Once archived, if you need to go back to a patient
who has been Archived and deleted from the Patient List, you can go to the Archive
folder and restore the patient back to the Patient List.

Archive Type
From the toolbar, you can
select an Archive Type.
Archive Type “Full”, will
copy all patient data,
including the entire
Holter recording and
report; and Archive Type
“Report only” will save
an electronic version of
Change Archive Type from toolbar
the patient’s Holter
report, including ECG
strips, but not the recording.
Note: Only by doing an “Full” Archive, can the patient’s Holter data
be restored and reanalyzed.

NorthEast Monitoring, Inc
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Archive Patient Window

Archive Patients Tab
The HE/LX Patient Archive Tool will initially
open with the “Archive Patients” tab selected.
Once opened, all patients who can be archived
will be highlighted in blue. A patient is highlighted in blue when:
1. They have been analyzed
2. They have a report
3. They have never been archived previously,
or their information has been updated
since they were last archived.
If you want to override the highlighted
patients, you can hold the Shift-key and click
on any directory in order to manually select or
deselect it. When finished, click the “Archived
Selected Patients” button at the bottom of the
screen and the selected patients will be copied
to the Archive folder.
Note: If a Patient is opened and viewed, but
not updated, the system will perceive this
patient as being updated and show that the
patient needs to be archived again. To ensure
that this does not become a problem for you,

NorthEast Monitoring, Inc

be sure to wait to archive a patient until you
are sure that they will most likely not be
viewed or reviewed again.

Delete Patient Records
Once archived, you will want to delete the
patients from the Patient List in order to make
room for new patients. The Archived check
box, labeled “A” on the Patient List, will show
you which patients have been archived and can
be deleted at this time.

Customizing Screens
Just like the
primary Patient
List, you can
customize any
of the archive
lists by changing, moving
and resizing columns. Select columns by rightclicking on any of the column headings and
then on “Update Columns.” You can also
search on each list by typing into the Search
box at top of the screen.
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Restore Patient Tab

Restore Patients Tab

Delete record after Restore

You can only restore patients when a Full
Archive type has been performed.

At this time, if you want to delete the
Archived record of the patient you just
restored, you can go to the toolbar and
select Archive > Delete Selected Archive
Record.

To restore a patient that has been archived
and deleted from the Patient List, select the
Restore Patients tab on the HE/LX Patient
Archive Tool. When selected, it will be
blue. You will now see a searchable list of
all archived records on the right. Select the
archived patient you want to restore on the
right, and an empty patient directory on the
left. Then click the Restore Selected
Record at the bottom of the screen to copy
the patient back to the Active Patient List.

Restore “Full” Archived Records

NorthEast Monitoring, Inc

Restore Patient Tab

Report only Archive
If you archived
patients using the
“Report Only”
option, you will not be able to restore those
patients as they no longer have the ECG
file. Instead, you can View the patient’s
report by clicking on the View button at
the bottom of the screen.
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Auto Archive
The Archive process consists of two
actions, both of which can be run automatically on a schedule or initiated by you by
clicking the Auto Archive button from the
Archive Window. The two pieces to
archiving are:
1. Copy a patient from the Patient List to
Archive after a defined number of days
that the patient has a report created or
modified
2. Delete the patient from the Patient List
after a defined number of days after
the patient has been Archived and no
subsequent changes to the patient have
been made.

Scheduling Auto Archive
You can schedule the Archive program to
run in the background. You can do this by
setting up a Scheduled Task from Control
Panel > Administrative Tools. The command that should be entered where “c:nm”
is the location where the HE/LX Analysis
is installed:

Java must be installed for the Archive program to run. The Archive.ini file in that
directory can be modified to meet your
specific business needs.

Archive.ini
An Archive.ini file is included in the
installation in the bin directory. The directory where the archived files are saved can
be changed here. Additionally, the number
of days criteria used to Archive and/or
Delete patients can be found and edited in
this file. They are:
• AutoArchiveDays - the number of days
after a patient has a report created that
the patient will be copied to the archive
directory. Make -1 to turn this feature
off.
• AutoDeleteDays - The number of days
after a patient is archived that the
record will be deleted from the Patient
List. Make -1 to turn this feature off.

“c:\nm\java\bin\java -jar
c:\nm\bin\archive.jar -auto”

Scheduled Task Example
NorthEast Monitoring, Inc
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7. U TILITIES &
L ICENSING
Two additional utilities have been installed with the HE/LX Analysis Software - 1)
HASPFinder and 2) Settings. Both may be found under “NorthEast Monitoring” on
the All Programs list

HASP Software Key and HASPFinder Utility
The HASP
software key
must be
plugged into
your computer or a
Sentinel HASP key visible network, and a
license.ini file must exist for the
HE/LX Analysis software to run.
The HASPFinder utility will look
up and show you if a NorthEast
Monitoring HASP key is visible
to the computer. HASPFinder
will also tell you if the HE/LX
HASPFinder Utility Screen
Analysis has a license.ini file and
if the license.ini file matches the
HASP key. See Appendix B for more information on Network installations as additional software is required.

License (registration)
If you have a Timed or a Pay-per-Use license, or if you have a customer code linked
to your software, all of that information can be found using the HASPFinder Utility.
When the HE/LX Analysis software is running, the type of license that you have is
visible at the bottom of the screen: There are three types of licenses: Permanent,
Timed, and Pay-per-use (The system counts every time a new patient is analyzed).
Contact NorthEast Monitoring technical support or your Channel Partner if you
have a Timed or Pay-per-Use license that needs to be renewed or adjusted.

NorthEast Monitoring, Inc
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Settings Utility

Number of Patients

The Settings window contains information
specific to your facility and the HE/LX
Analysis software. Here you can enter the
names of both your facility and the primary user of your Holter software, along
with five lines for the name and address
that appear in the Reports window when
you go to print a Holter report.

To change the number of directories stored
on the Patient List, you can enter a different number here. If you choose to increase
the number, additional directories will be
created, but if you need to decrease the
number of directories, you will need Windows Explorer to do so, but be sure that the
directories you are deleting are either
empty or the patient data has already been
archived. See Chapter 6 for more information on Archiving.

Patient Directory Location
Starting with Holter LX Analysis 5.4e and continuing with HE/LX Analysis 6.0, all patient
directories exist in a single directory. The
[PatientParentDir] denotes the directory location and size and can be found at the top of the
h4w.ini file. Below are some examples of how
it should appear:
[PatientParentDir]
c:\nm60\pat, 30
[PatientParentDir]
c:\nm\pat, 100

Settings window

Changing Language
The drop-down box will show the list of
languages that are currently supported in
the software. To change the language used
throughout HE/LX Analysis, make your
selection from the drop-down menu associated with the Language field. In order to
have the languages be presented throughout the system, you should now create a
new configuration using your new language so that report names, etc. are correct
throughout. The “Standard” configurations
will always remain in English.

NorthEast Monitoring, Inc

[PatientParentDir]
\\shared_dir\nm\pat, 30
;Network example.
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A PPENDIX A C ALCULATION OF
H EART R ATE
Types of heart rates
A variety of heart rate calculations are made by the HE/LX Analysis software. They include:
• Current heart rate
• Minute-by-minute heart rate
• Beat-by-beat heart rate
• Mean heart rate in intervals
• Mean heart rate for Holtered period
• Second heart rate
• Heart rate strips

Current heart rate
This is a complex function that takes the current beat and the beats preceding it into account. This weighted average follows these rules:
3. If the differences between the adjacent beats of the preceding four RR
intervals are no more than 12 percent of the average RR interval for the
previous beat and the beats are all normal, then the new average RR
interval is the simple average of the previous four RR intervals.
4. If the previous four RR intervals were NOT bigeminy, VTAC or SVT
AND the current RR interval is within 25 percent of the previous
average AND the previous two beats were not ventricular AND the
previous 10 beats were not supraventricular, then the new average RR
interval is 1/8 of the current RR interval plus 7/8 of the previous
average.
5. If the previous four RR intervals were NOT bigeminy, VTAC or SVT
AND the current RR interval is not within 25 percent of the previous
NorthEast Monitoring, Inc
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average OR any of the previous two
beats were ventricular OR any of the
previous 10 beats were supraventricular,
then the new average is 1/32 of the
current RR interval plus 31/32 of the
previous average.
6. If the previous four RR intervals were
bigeminy, VTAC or SVT, then the
average RR interval is changed by
0.000087 seconds. It is increased if the
current interval is longer than the
previous interval, otherwise it is
decreased.
Once the current average RR interval is
determined, the current heart rate is calculated as 60 divided by the current average
RR interval, that is, current HR = 60/(current RR interval).
The current heart rate is used as the heart
rate that appears in the heart rate data field
for any displayed strip. This includes the
heart rate associated with any strip in the
Selected Strips window and in the printed
report.
The current heart rate is also used to detect
tachycardia and bradycardia. The onset of
either is determined to be when the current
heart rate reaches the tachycardia or bradycardia settings in the Scanning Criteria
window.
The low and high heart rates reported in
the Tables window and in the tables of the
printed report refer to the lowest and highest current heart rate calculated during the
interval.

greater, then the HR upper limit is = 30 /
(additional dead time).

Minute-by-minute heart rate
The heart rate plotted in the Trends window is a minute-by-minute heart rate. It is
calculated as 60 times the number of beats
processed in the minute divided by the sum
of all RR intervals of beats processed in
the minute (in seconds).

Beat-by-beat heart rate
The heart rate associated with each beat in
expanded displays whenever the Annotation field in the Preferences window is set
to Heart Rate is the beat-by-beat heart rate.
It is calculated based on the RR interval
following the labeled beat. Beat-by-beat
heart rate equals 60 divided by RR interval, that is, HR = 60/(RR).

Mean heart rate in intervals
In the tables (in Tables window and printed
report), the mean heart rate within each
interval is calculated by dividing the number of beats in that interval by the amount
of time processed within the interval.

Mean heart rate for Holtered
period
In the Report Summary (in the Report
Summary window and printed report), the
mean heart rate during the Holter test is the
number of beats counted divided by the
amount of time processed.

Heart Rate calculation limits
The absolute limits are 20 and 300 (3 seconds to 0.2 seconds). If the “additional
dead time” is not set to zero, then this
upper limit can be lowered further. If the
“additional dead time” is set to 0.1 or

NorthEast Monitoring, Inc

Second heart rate
The second heart rate is the heart rate associated with a run of VTAC or SVT. It is
calculated as 120 divided by the sum of the
current RR interval and the previous RR
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interval. The second heart rate appears in
strips with VTAC or SVT in Selected
Strips, the printed report, and the strip list,
labeled HR2.

dead-time built into the software adjusts
based on the current heart rate. At higher
rates, the dead-time decreases, and at
lower rates, the dead-time increases.

The second heart rate is used to determine
where in the ventricular and supraventricular run tables a run of VTAC or SVT
appears. The heart rate separating fast
from slow runs is determined by the VTAC
and SVT settings in Scanning Criteria, but
the rate of each event is considered to be
the second heart rate.

Likewise, the definition of an R on T,
which is a VPB falling on the T-wave of
the preceding beat, varies with heart rate.
Since the software does not identify Twaves, it cannot determine whether a VPB
is actually falling on the T-wave of the preceding beat. But the software can calculate
where the T-wave for a beat should be and
then alert the operator regarding any VPBs
that fall within that hypothetical area.

The second heart rate is also used to determine which run is identified as the fastest
run of VTAC and SVT.

Heart rate strips
In the Critical Events window, there is a
choice in the Type field called “HR strips.”
This displays all ECG from the Holter test
divided into 7.5-second strips. Each strip
includes a time-of-day and a Strip HR.
That Strip heart rate is the total number of
RR intervals (including partial ones, but
excluding artifact) within the strip divided
by the sum of the RR intervals.

Defining dead-time and RonTs
Dead-time is the amount of time (in seconds) after a detected QRS complex during
which the software will not look for
another QRS complex. Generally, this
helps to prevent the mis-identification of
tall T-waves as QRS complexes.
The operator can add more time to the tail
end of the dead-time using the Extra deadtime setting in the Scanning Criteria window. An increase in the Extra dead-time
should be done judiciously so that very
early VPBs do not fall within it.

The heart rate determines the dead-time
and R on T period definitions as shown in
the following table:

How heart rate determines
dead-time and R on T

TABLE 1.

Heart
rate

Deadtime

30

0.500
00
0.500
00
0.500
00
0.500
00
0.435
00
0.387
27
0.347
50
0.313
84

35
40
45
50
55
60
65

Because the recovery time (i.e., the width
of the T-wave) varies with heart rate, the
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R on T

0.600
0.542
0.500
0.466
0.440
0.418
0.400
0.384
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How heart rate determines
dead-time and R on T

TABLE 1.

Heart
rate

Deadtime

R on T

Heart
rate

Deadtime

70

0.285
00
0.260
00
0.238
12
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.220
00
0.214
28
0.206
89

0.371

150

0.360

155

0.350

160

0.341

165

0.333

170

0.326

175

0.200
00
0.193
54
0.187
50
0.181
81
0.176
47
0.171
42

TABLE 1.

75
80
85
90
95
100
105
110
115
120
125
130
135
140
145

NorthEast Monitoring, Inc
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dead-time and R on T
R on T

0.280
0.270
0.265
0.261
0.257
0.253

0.320
0.314
0.309
0.304
0.300
0.296
0.292
0.288
0.285
0.282
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A PPENDIX B N ETWORK
I NSTALLATIONS
Network HASP Key Installation
System Requirements:
7. The network HASP key server should be a minimum of a Windows 7,
which is visible (can be pinged) from each client computer.
8. The network HASP key server must have one USB port available.
9. Port 1947 must be available on all computers for use by the Safenet
drivers.

Installation:
1. Install the HASP User Setup on the network license server. During this
installation, the installer will ask for permission to modify the firewall
(if any) to allow network access to the Safenet drivers. This must be
allowed.
The current HASP installer is available at www.nemon.com on the
Downloads and Documents page.
2. Put the HASP key in an available USB port on the server. Using USB
hubs is allowed.
3. On each client computer, install the HE/LX Analysis program, and the
Adobe Reader if prompted to do so. By default the HASPFinder utility
will also be installed.
4. Install the license.ini file on each client computer.
5. Run the HASPFinder software on each client to verify that the HASP
key can be seen from each location. The HASPFinder should also see
the local license.ini file and confirm that it matches the HASP key.
6. Run the HE/LX Analysis program to confirm installation is successful.

NorthEast Monitoring, Inc

NEMM026-Rev_K

Page 51 of 56

HE/LX Analysis Operator’s Manual - Basic

Appendix B - Network License Installation

Setting up Shared Network Patient Data
Beware that this will slow down response time, depending on the speed of your network.
If you choose to set up network patient data, do the following below.
First, determine the location and number of patient directories.
Then, on each client machine, open the h4w.ini file that is located in the c:\nm\bin directory and do the following:
1. Delete the following 3 lines:
[Current]
PatDirLoaded = C:\nm\pat\xx
PatDir = C:\nm\pat\xx
2. Modify the line that immediately follows [PatientParentDir]:
from: c:\nm\pat, xxx
to the network path for the base of the patient directories followed by a comma and the
number of directories that you choose to have created initially.
Next, start the HE/LX Analysis software on a single client machine. It will create the number of directories you specified on the network machine. (The system may fail as there is
no demo patient yet.)
Lastly, and very important, copy and paste the “demo” patient directory from the client
machine to the patient directory on the network.
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Windows 2008 Server Installation
First, each user needs a directory assigned to it in the form of “c:\user\test1” for user test1.
The user name should have no spaces. If there are spaces in the user name, then a logical
redefinition will be required as the HE/LX Analysis program will not accept spaces in the
path of the patient directories.
Then assuming the user names are of the form testxxx, the following has to be done:
1. Make a dummy installation of the HE/LX Analysis onto the C drive in the normal location c:\nm.
This installation will not actually be used.
2. Copy the license.ini file into the c:\nm\bin directory.
3. Copy and paste the full directory (c:\nm) into each user directory c:\user\testxxxx, resulting in a
bin path of the form c:\user\test1\nm\bin.
4. The file c:\user\test1\nm\bin\h4w.ini must be edited so that each instance of c:\nm\ is changed to
c:\user\test1\nm\

5. See “Setting up Shared Network Patient Data” to allow for sharing of patient files
Now it should be possible to login to each user with "Remote Desktop Connection" and
have all copies running at the same time up to the limit of licenses in the network key(dongle).
Once everything is up and running, if the number of users exceeds the number of licenses allowed,
a message "no NEM dongle found" or a "no matching license" will appear.
If the space in user name limitation is a problem, it should be possible to use MKLINK to create a
logical name which is acceptable.
It should be possible to create a script to do all this for each new user.
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A PPENDIX C - LX
S LEEP - A PNEA
LX Sleep - Apnea Installation
Requirements:
You will need the following in order to run LX Sleep - Apnea as part of your HE/LX Analysis
software:

1. A HE/LX Analysis license that allows for LX Sleep. This license file comes with
your software and once installed will be labeled license.ini.
2. An additional license file called license_AHI.ini. to enable LX Sleep. This file
should be loaded into your c:\nm\bin directory or the bin directory where the HE/
LX Analysis software was installed.
3. A Sentinel SuperPro USB dongle key to enable LX Sleep.

Installation:
Additional software requirements are:
• When installing HE/LX Analysis, do a “Complete” installation of the HE/LX
Analysis software. The installation will require loading MATLAB and special
Microsoft C++ software.
• Additionally, you will need to have Sentinel Protection Software installed. This
software can be found on the install DVD under support_files or at nemon.com on
the Technical Support page under Support Files.
• Under Support Files you can also copy the Dongletest.exe file to the bin directory
of your installation. When run, Dongletest will confirm that the system can see the
SuperPro USB dongle key.

Troubleshooting
If for some reason you cannot start the HE/LX software and are getting the message that there
is no license, confirm that the license. ini and license_AHI.ini are set up correctly.
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Appendix C - Test Issues

Apnea Trend / AHI Probability chart
If you purchased the LX Sleep feature, and are using the OxyHolter Recorder, an apnea
probability trend will appear at the below the Oximetry trend. The Apnea Trend will calculate an AHI# for a patient once Apnea analysis is run. A set of buttons labeled “Apnea”
at the top of screen allows you calculate the AHI# and also allows you to turn on/off time
periods from being included in the AHI (apnea probability index) analysis.

Apnea Analysis s

Only data highlighted in blue is considered when determining apnea probability or the
AHI. To turn on or off data, highlight the area (turns pink) on the Apnea trend using your
cursor, and press the appropriate - On or Off - button. Click Apnea -> Run Apnea to get
the new AHI for the selected time period. HR or Oxy trend data that has been highlighted
as being artifact, will be automatically excluded from the analysis.
Once an AHI# is calculated, you will see the updated Apnea trend and the Apnea Probability Chart on the bottom of the screen. If your patient’s calculated AHI# is less than 5, no
OSA has been detected. If the AHI# is 5 or greater, and less than 15, then OSA is possible.
For patient’s with AHI# of 15 or greater, there is a high probability of OSA.
In order for the Apnea analysis to work, at least 4 hours of time must be included in the
AHI calculation. By default, the system uses recording time between 9pm and 8am as the
start and stop times, and you can override the start and stop times by highlighting the
Apnea trend and using the Apnea On / Off buttons at the top of the screen. If for some reason the system is unable to calculate an AHI, it will return a message “AHI# cannot be calculated using selected Apnea trend” of “NaN” (not a number.) This is most likely because
not enough time was included in the calculation of AHI either because of excessive artifact, especially on channel 1, or too short of a sleep period.

Apnea Analysis Outputs
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A PPENDIX D -TEST
I SSUES
The following is a list of issues that have been identified in this version of
the software:
1. When modifying the front page, a user cannot cut and paste from Microsoft Word. The user can cut and
paste from Notepad.
2. If you use installer to Modify software, the desktop links may break. Running the installer again in
Repair mode will fix the links.
3. The status window may not appear while analyzing local patients.
4. Calibration on Oxy and 12-lead patient will cause the system to not recognize the recording type until
an update is performed. An Update can be performed at any time from Review on the toolbar.
5. Apnea (Sleep) cannot run over the network.
6. For Sleep patients, if the user changes the times that are included in Full Disclosure on the Reporting
screen, the AHI# will have to be recalculated.
7. For Sleep patients, if the user updates the trend, you will need to do a manual Update before calculating AHI# as the system will update the data again once you leave the trend screen and the AHI calculation will be lost.
8. In Norwegian only, Gain on the Page screen cannot be used. If Gain is changed, ECG on the reports
will not appear. If this does occur, you will have to copy the flash.dat to a new patient directory and
start over.
9. 12-lead strips labels are in English for Russian translations. Unicode characters cannot appear in these
fields.
10. For network installations, if oximetry desaturation is turned on or off, the system will become very
slow.
11. For network installations, the Preference that allows users to create a default Saved Strip sort, does not
work when multiple view and time are selected.
12. When the operating system is set to a region that uses commas instead of periods to reflect decimal
points, the Spectral Analysis will be unable to create 24-Hour Plot and the Frequency Domain Table.
13. Some screen preferences are lost after doing an update or reanalyzing. This includes Morphology on
the Page screen, as it always reverts to Single mode.
14. Minimum Time between Strips not working
15. Desaturation Table - Right clicking and double-clicking on a line does not function as advertised.
16. License message at bottom of screen & patient box too big that sometimes the patient selection box
falls off the screen. Widen the screen to fix this problem.
17. On some desktops, Apnea crashes because it cannot see dongle
18. 24 hour plot fails when Spectral Size is set to 100 secs in Settings
19. Table updates do not appear on report for network patients. If you close the patient and then reopen,
the report will be updated as per the edited tables.
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